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Installing the Network Software Protection Key

1. Introduction

The network version of SES Software must be installed in two stages. The workstation portion of the soft-

ware must be installed at the end-user site, and the server components must be installed on the host

server by a network administrator. This document describes the installation and configuration procedures

for the server components of the software. The installation of the client part of the software proceeds

through the standard SES Software installation program; simply select Use Network License in the License

Type dialog.

The server installation is quite simple, and comprises only the licensing components of the software,

namely:

l A hardware security key and associated device driver.
l A service that establishes a bridge between the client applications and the hardware key.
l Optional monitoring tools.

It is very important to secure the software license pro-

tection key at all times, and highly recommended to

have it insured1. If the key is missing or defective, the

message shown to the right is displayed every time

there is an attempt to access a protected software pack-

age or utility. It is imperative to communicate with SES

prior to returning a key for any reason (upgrade, replacement, etc.), and to use an approved courier ser-

vice, such as Federal Express or UPS, for the shipment.

2. For a Quick Start...

For installation scenarios involving a single SES Software network software protection key, installing and

configuring the network key is straightforward. The basic steps are as follows:

1. Select any computer on the network on which to install the software license protection key,
the NetHASP License Manager (LM), Sentinel LDK Run-time Environment driver. We recommend
you choose a network server, since this is less frequently rebooted, but any computer works just
as well.

1 SES offers an insurance service that protects your investment and, in case of loss or theft, ensures the prompt
replacement of your key. If you have an active support service, then you automatically have this insurance. If 
you have any questions, please contact SES.
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2. Install the NetHASP License Manager (LM) on that computer. To do this, run the setup file
lmsetup.exe from the Tools | NetHASP | Server | win32 folder under the distribution folder. By
default, this folder is called Setup and is located under the SES Software Documents folder. You
can open this last folder using Start | All Programs | SES Software | Program Folders |
Documents Folder . If the Setup folder is missing, please rerun the full installation of SES
Software to generate the distribution folder.

3. Install the Sentinel LDK Run-time Environment driver: run HASPUserSetup.exe from the Tools
| HASP | Install folder on the SES Software distribution folder.

4. Connect the software protection key and activate the network key from one of the client
computers (see Software License Protection Key – Updating the Expiration Date).

Note

SES Software 17.0 supports Sentinel network key, you could skip the above step 2 if you have a

Sentinel network key.

You may go to the page http://localhost:1947/_int_/devices.html2 to verify if your key is a Sentinel 

network key, if so, it should list a HASP HL Net key for the Vendor 57923. If you received your 

key before April 2021, you need to update it as well, in order to use it as a Sentinel network key. 

SES recommends you to upgrade it since it is more fast and easy to manage your license.

Note

The license can be used only for SES Software 17.0 and higher version after upgrading. Refer to the

following section (“How to upgrade your key”) for more details. If you have an old NetHASP key,

please contact our sales department for a replacement of your key.

Refer to the following section, Server Installation of a Sentinel network Key, for more details on the avail-

able installation and configuration options when installing a Sentinel network key.

Note

The following description only applies to the legacy NetHasp Key.

This technique uses general broadcasting to allow the clients to discover the license server. If you are con-

figuring for multiple network keys, then the IP address method should be used instead of broadcasting 

since you will want each client to be able to acquire a specific license that is available on the network; 

broadcasting does not offer this level of control. Please see the section Using SESNetKey to Configure Net-

work Keys for help in doing that.

2 Access to Sentinel Admin Control Center requires the installation of Sentinel LDK Run-Time Environment: 
HASPUserSetup.exe. The driver is installed at the same time.

http://localhost:1947/_int_/devices.html


To install more than one network key, repeat Steps 1 and 2 above for each key, using a different server for

each key. Next, configure the clients to use those keys, as described in the section Using SESNetKey to

Configure Network Keys.

Refer to the following section (Server Installation of a NetHasp Key) for more details on the available

installation and configuration options when installing a network key.

3. How to Upgrade your Key

1. Go to http://localhost:1947/_ int_ /config.html 3, and for the setting Generate C2V file
for HASP key, select Enable this option only if recommended by your software vendor.

2. Click Sentinel Keys under Options or go to http://localhost:1947/_int_/devices.html4, locate the
SES key with Vendor 57923,

3. Click the C2V button to save your key's c2v file, and send us the file by email.

3,4 Access to Sentinel Admin Control Center requires the installation of Sentinel LDK Run-Time Environment: 
HASPUserSetup.exe. The driver is installed at the same time.

3

4. After receiving the c2v file for your key, SES will send you a license file to disable your current 
NetHasp license, and a V2C file to upgrade your key with Sentinel license.

5. Click Update/Attach to go to the update/Attach page.

6. Click Choose File to select the V2C file from SES.
7. Click Apply File.

http://localhost:1947/_int_/config.html
http://localhost:1947/_int_/devices.html
mailto:KeySupport@sestech.com


Server Installation of a Sentinel network Key

4. Server Installation

1. Start the program Tools | HASP | Install | HASPUserSetup.exe from the distribution folder.
2. Follow the wizard instructions.
3. Insert SES USB red dongle in the USB port on your server. If your server is a virtual server, you

could use USB over IP device to mount the dongle to the server.
4. The red LED on the USB Dongle should light up.

5. Server Management

Navigate to Control Panel > Administrative Tools > Services and make sure that the Sentinel LDK

License Manager service is running.

The Sentinel Admin Control Center allows you to check which clients are currently connected to the 

server PC and using the products. This can be accessed by going to http://localhost:19475 in any 

browser. The sessions page will show which clients are using licenses.

5 Access to Sentinel Admin Control Center requires the installation of Sentinel LDK Run-Time Environment: 

HASPUserSetup.exe. The driver is installed at the same time.

4
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6. Client configuration

1. Run SESLicenseManager from SES Software shortcut ( SES Software | System |
SESLicenseManager).

2. Click the Check button.
3. Select Sentinel Key and follow the wizard instructions.

Note

The Sentinel LDK License Manager uses port 1947 for communications - so please ensure that the

port is open and that the program itself is allowed through the firewall.



Server Installation of a NetHasp Key

The installation of the NetHasp licensing system involves the following steps:

l Installation of the License Manager and of the device driver for the hardware key.
l Configuration of the License Manager.
l Configuration of the clients.

In a network where more than one key is installed, this last step requires special considerations, as

described in the section entitled Using SESNetKey to Configure Network Keys.

7. Installing and Configuring the License Manager
7.1 Installation Considerations

The License Manager can be installed on anyWindows platform. The License Manager should be installed

as a service – thereby avoiding the need to log into the server for the License Manager to be operational.

The HASP License Manager can be installed on a virtual environment only if the virtual server supports

USB, meaning that the key server is able to detect the SafeNet HASP key in the device manager.

For better performance, please don't overload the license server, make sure there is always one physical

core to take care of background service calls; this will allow the license service to continue to operate

even if the other server cores are overloaded.

7.2 Configuration

You can modify the behavior of the License Manager in two different ways:

1. By editing the configuration file nhsrv.ini . The syntax of this file is described in the file
Tools\NetHASP\Server\win32\nhsrvw32.hlp in the distribution folder, under the topic
NetHasp License Manager Configuration File. If a configuration file is customized, it should be
placed in the same folder as the installed License Manager executable file (nhsrvw32.exe). A
sample configuration file is available at Tools\NetHASP\Server\nhsrv.ini.

2. By providing command line switches when starting the license manager. The topic Command-
Line Switches in the file Tools\NetHASP\Server\win32\nhsrvw32.hlp in the distribution folder
gives a complete list of the available command line switches.

Usually, the default configuration of the HASP License Manager is satisfactory. The settings that are most

often changed are:

l The communication protocol . By default, NetHASP tries IPX, NetBIOS and TCP/IP. For greater
efficiency, you can restrict this to one or two protocols. This is better done through the user-
interface of the license manager.

6
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l The port number used to communicate with the clients under TCP/IP. By default, this is 475. It can
be set through the portnum command-line switch.

7.3 Installation Steps

To install the HASP License Manager:

1. Start the program Tools\NetHASP\Server\win32\lmsetup.exe from the distribution folder.
2. Follow the initial steps of the wizard until prompted to select an Installation Type.
3. Select the Service option to install License Manager as a service with default settings. It is

important that you do not select the Application option.
4. Select a directory and program folder for the License Manager, and click Next . The License

Manager will be installed.
5. You may be prompted to install the HASP device driver. If so, select No.
6. Choose to start the license manager when prompted.

To install the key driver:

1. Start the Sentinel Run- time Setup Tools\HASP\Install\HASPUserSetup.exe from the
distribution folder.

2. Follow the instructions in the wizard to install the key driver.
3. Plug your software license protection key into a USB port.
4. Your license manager is now ready for use.

Note

The NetHASP License manager uses TCP and UDP ports 475 and the Sentinel HASP Run-time Envir-

onment uses port 1947 for communications - so please ensure that these ports are open and that the

program itself is allowed through the firewall.

8. Starting and Stopping the License Manager

When the License Manager is installed as a service the License Manager is configured to start auto-

matically. To start or stop it manually:

l Start the License Manager from the Services applet. The License Manager is identified as Hasp
Loader in the services list.

l Stop the License Manager from the Services applet.

You can also start and stop the License Manager from the Monitor tool. See the section The Monitor

Tool for more details.

From time-to-time, the HASP Loader service on the license server may become overwhelmed. It is a good

practice to periodically (say, once a week) restart this service. The restart operation will not be disruptive

to ongoing runs and work in the GUI.



9. Using SESNetKey to Configure Network Keys

The utility SESNetKey that is installed with all SES Software packages helps to build a valid NetHasp.ini

configuration file that enables the clients to communicate efficiently with the NetHasp license managers.

It allows you to do two things:

1. Build a configuration file (SESNetKey.ini) that contains the network address of the servers to
which the keys are connected and other information that helps identify the keys uniquely.

2. Once the configuration file is distributed to the clients and placed in their SES Software
Documents folder, it allows the clients to select which of the keys to use from this point forward.
It does that by generating a suitable NetHasp.ini configuration file according to the user’s choice,
and placing it in the SES Software Documents folder.

The following steps show how to run the SESNetKey utility to specify the IP address of the license man-

ager servers.

1. Run SESNetKey from the Start | All Programs | SES Software | System menu.
2. Click the Optionsmenu, and check the Administration menu item.
3. Click the Edit | Add menu item, or click the Add button on the toolbar.
4. In the Key Properties panel, enter CDEGS (or any other unique name) as the Key Name, select

NetHasp as the Key Type, enter the IP address of the server as the IP Address, and then click the
Add button.

5. Repeat Steps 3 & 4 for all remaining license manager servers.
6. Click the File | Save menu item to save, and then close SESNetKey.

Note

This procedure requires that SES Software be installed. Consult the Installation Guide for help on how

to do that.

In the current version of the software, it is only possible to access a single hardware key8 at a given time. 

When more than one key is installed on the network, the user must select the key that should be 

queried when the SES programs perform a license check. It is important to notify users that they have 

to use the SESNetKey utility at least once, to specify the initial key that they want to use. Otherwise, 

the software may not run correctly.

The above steps are sufficient to configure a client computer to use one or more keys located on servers 

with specific IP addresses. It could be repeated on every client computer, but a simpler method is to

8 In the current version of the NetHasp key, it is not recommended to physically install more than one key 

in any server or workstation.

8
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distribute the file SESNetKey.ini created by those steps to all other clients. This file is located in the SES

Software Documents folder. Click Start | All Programs | SES Software | Program Folders | Documents

folder to open File Explorer in that folder.

To configure a client computer when a SESNetKey.ini file is available:

l Copy the SESNetKey.ini file to your SES Software Documents folder (You can open it from Start |
All Programs | SES Software | Program Folders | Documents folder).

l Run SESNetKey from the Start | All Programs | SES Software| System menu.
l Select the appropriate key server in the list and save the configuration using the Save option from

the File menu.
l Exit SESNetKey using the Exit option from the File menu.

SES Software will be configured to use the network software protection server. If you have more than one

network software protection server, and you need to be able to switch between servers, you may wish to

create a shortcut to the SESNetKey utility for convenience. Consult the SESNetKey ’s online help for

details on how to use the utility.

10. Configuring the Clients

You can configure the way the SES programs communicate with the License Manager(s) by customizing

the NetHasp.ini file. The most important parameters that can be modified in the NetHasp.ini file are:

l The network protocols that should be used when communicating with the License Manager. Note
that this should be configured in the same way as for the server. This is set by the keys NH_IPX, NH_
NETBIOS , and NH_TCPIP in the section NH_COMMON . For example, the following fragment of a
NetHasp.ini file restricts the protocols to TCP/IP:

[NH_COMMON]

NH_IPX = Disabled

NH_NETBIOS = Disabled

NH_TCPIP = Enabled

l Whether or not to use broadcasting under TCP/IP. This is controlled by the key NH_USE_BROADCAST
in the NH_TCPIP section.

l The IP Addresses (or host names) of the servers where the License Manager(s) to be queried for a
license are installed. This is controlled by the key NH_SERVER_ADDR in the NH_TCPIP section. For
example, the following fragment of a NetHasp.ini file instructs the client to look for licenses only on
the SES Software-Server machine:

[NH_TCPIP]

NH_SERVER_ADDR = SESSoftware-Server

NH_USE_BROADCAST = Disabled



In principle, several servers can be specified simultaneously, although for the current version of the

software, it is better to restrict every client to a single License Manager at a time. See the section

entitled Using SESNetKey to Configure Network Keys for more details.

l The port number to be used under TCP/IP. This is controlled by the key NH_PORT_NUMBER in the NH_
TCPIP section, and should be set to the same value as the corresponding license manager.

The customized NetHasp.ini file must be placed in the SES Software Documents folder of the clients for

the customization to take effect.

If you have timeout and communication issues:

Try adjusting the following settings:

[NH_COMMON]

NH_SESSION = <Num>

NH_SEND_RCV = <Num>

where <Num> is a time in seconds.

l NH_SESSION sets the maximum length of time during which the application tries to establish
communication with the NetHASP License Manager. The default is 2 seconds.

l NH_SEND_RCV sets the maximum length of time for the NetHASP License Manager to send or
receive a packet. The default is 1 second.

11. Using SESLicenseManager to Configure Concurrent Runs

If you have a network license for N users (with N > 1), you may use SESLicenseManager to enable one user

to run up to N cases concurrently on a single machine. This operation is referred to as reserving the

license. At most one user can reserve the license in this way. When a user reserves the license, the seats

that are reserved are not available to other users of SES Software using that same network license, until

the license is restored.

It is important to make sure that no one else is using the network key when you use SESLicenseManager to

reserve the license, since this operation will terminate the active sessions of all other users that are using

that key.

10
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The following steps show how to run the SESLicenseManager utility to reserve the license for concurrent

runs.

Note

To enable the Concurrent Runs Configuration feature in SESLicenseManager, you will need to add

the line ENABLE RESERVED KEY FEATURE=T to the SESSECUR.INI settings file under the [GENERAL]

section, as shown in the example:

The settings file can be found in the SES Software documents folder       

(C:\user-s\public\documents\ses software\17.0).

When you are no longer using this feature, you should remove the line from the settings file, or set its 

value to 'F', in order to maintain the performance of the network licenses.

1. Run SESLicenseManager from the Start | All Programs | SES Software | System menu.
2. Click the File menu, and click the Concurrent Runs Configuration menu item.
3. Click the arrows to increase the Number of Concurrent Runs, enter your phone number (or any 

information allowing other users of the network key to identify you) in the Notes textbox, 
and then click on the Reserve button.

4. Click Yes when the Please note that if other SES Software applications are currently running 
with the key, they will be terminated. Warning messages will show.

After reserving the license, you can use SESBat to run multiple concurrent runs. To do this, increase the

Number of Concurrent Runs in the Batch Options tab of SESBat, and then start the runs.

Once the concurrent runs are completed, you should use SESLicenseManager again to release the license

so that other users can use the key. To release the license:.

1. Run SESLicenseManager from the Start | All Programs | SES Software | System menu.
2. Click the File menu, and click the Concurrent Runs Configuration menu item.
3. Click on the Restore button to release the reserved license.



Note

The Restore command can be used by any SES Software user on the network when the license is

reserved, not only by the user who reserved the license. Again, you should make sure that no one else

is using the network key when you use SESLicenseManager to restore the license, since this operation

will terminate the active sessions of other users that are using that key. In particular, one should con-

tact the user who reserved the license before clicking the Restore button because all concurrent runs

will be terminated once you release the reserved license.

12. Using SESLicenseManager to Configure License Usage Logging

You can monitor usage of a network license by activating the license usage logging feature. When this fea-

ture is activated, the following information is stored in a log file when ending an interactive session:

User Name, Computer Name, Key Label, Application Name, Login Time/Date, Logout Time/Date,
Total Usage Time (seconds)

The following steps show how to run the SESLicenseManager utility to configure license usage logging.

1. Run SESLicenseManager from the Start | All Programs | SES Software | System menu.
2. Click the File menu, and click the License Usage Logging Configuration menu item.
3. Click (…) to select a network shared folder, or type the full path of a network shared folder in the

provided box, and then click OK to activate the license usage logging feature.

To control the size of log file, you can add the Max Size Of Log File key in the GENERAL section in the

SESSECUR.INI file, as shown below:

[GENERAL]

Max Size Of Log File= <MaxSizeOfLogFile>

where <MaxSizeOfLogFile> is the maximum size of the log file in kB (the default is 64 kB).

This should be done on all client computers that are to be monitored. The SESSECUR.INI file is located in

the SES Software Documents folder (You can open it from Start | All Programs | SES Software | Pro-

gram Folders | Documents folder).

When the license usage logging feature is activated, the log file SESLicenseLog.csv will be created in the

network shared folder.

12
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Note

If the size of the log file exceeds <MaxSizeOfLogFile>, a backup file will be created with the name

SESLicenseLog.N.csv, where N is the number of backups. For example, if SESLicenseLog.000001.csv

exists, then the backup file name will use (000001) +1 for N , giving the filename SESLi-

censeLog.000002.csv . Also, a file named T-CDEGSXXXXCurrentUsers.log will be created in the

same folder. This file contains the current user list for the network key T-CDEGSXXXX, where T-

CDEGSXXXX is the key label.

13. The Monitor Tool

The Aladdin Monitor tool detects which HASP License Managers are currently loaded on the network, and

for each of them, shows which workstations (if any) they currently serve. It can also be used to start or

stop the Hasp License Manager service.

This tool is useful to help resolve installation problems, to verify if the License Managers are correctly

loaded, and to monitor the usage of the licenses.

13.1 Installing The Monitor

To install the monitor, start the program Tools\NetHASP\Monitor\install\aksmon32_setup.exe from

the distribution folder and follow the instructions. The program can be installed on the server, on the cli-

ent or on both.

13.2 Using The Monitor

To start the monitor, start askmon.exe from your selected installation folder. When loaded, the program

automatically detects the License Managers that are currently running over the network. The list of run-

ning License Managers appears to the left of the program.

You can obtain information about any License Manager by selecting it from the list; the information is dis-

played in the right pane, and includes the ID of the workstations that are currently serviced by the License

Manager, the maximum number that can be serviced, etc. Consult the program’s online help for more

details.



Software License Protection Key 
Updating the Expiration Date

14. SESLicenseManager Program

To protect our users, we have introduced a timed software license protection key which, if stolen,

becomes ineffective after a period of time. It is easy to maintain: simply reinitialize it with the supplied

SESLicenseManager program. The procedure for resetting the date on the protection key is described

below. Please close all SES Software programs prior to your software license protection key. Make sure

that you are running this procedure on the computer where the key is installed.

Note

SESLicenseManager must connect to SES's server over the internet while activating the software

license protection key. If the program is unable to connect to SES, you will be offered to use offline

activation with the following message, during the latter part of the activation process.

If you want to use offline activation, please send SES an

offline activation request file by answering Yes and

following the wizard.

After receiving the offline activation request, SES will

send you an offline license file that will work only for

the computer that generated the offline activation

request file

Before you start, make sure the network key is setup properly. You will need a license file from SES (or a

link to such a file) or the username and password of your support account.

1. In the Windows Start Menu, go to All Programs, then select SES Software x…x (where x…x
is the version number of the most recently installed version of SES Software).

2. Once you have opened the SES Software menu, click on the System menu.
3. In the System menu, click on SESLicenseManager.

14
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4. You will see one of the two screens that follow:

On this screen:
l The example shows a CDEGS

package. The Computation Modules
Programs panel displays which
modules are enabled by your
software license protection key. The
Included Packages panel displays
other packages included in your key.

l The type of soil model that can be
used with your software package(s) is
indicated at the left side of the
Restrictions section.

l The remaining panels show the type
of software protection license key
detected and its expiration date.

a. If you are presented with the screen above, select File | Activate License, or click the
Renew button on the toolbar to open the SES Protection Key Activation Wizard. The
Select License File screen appears if a software license protection key is detected, as
shown below.

b. Alternatively, you may be presented immediately with the Select License File screen:

The Select License File screen allows 
you to select a license file to activate 
your protection key. There are three 
options:

1. If you are under support, you
can use your username and
password to download your
license file automatically.

2. You may also use a temporary
link provided by SES to
download a license file.

3. You can select a license file
that has been provided by SES

5. Often, you will already have a license file, in which case you should choose the last option, I
have already received a license file , and click the Browse button to go to the directory
where you have placed the license file, which you should then select: it is a file named T-
CDEGS####.lic , where #### represents the ID number of your key. If you do not have a



license file, but have a link from SES or your support account username and password, then
use these instead. Click on Next.

6. The software will attempt to communicate with SES. If this process fails, then you will see the
screen shown at the beginning of this document. Follow the ensuing instructions to obtain an
offline license file dedicated to the computer you are activating and start the activation
process again with the offline license file, when you receive it.

The Key Activation Information screen

shows the information in your selected license

file. If the license file only contains expiration

data, it will display only the new expiration

date; otherwise it will display the full license

information.

The example shown here is for CDEGS key T-

CDEGS#### and assumes that the SES

Protection Key Activation wizard was

launched to reactivate the key until the given

date.

7. Read the information on the Key Activation Information screen. If you see anything wrong,
then contact SES. Click on Next.

Your protection key is successfully 

activated . will be shown in the Finished step 

when the license file has been accepted.

You may use the View License button to view 

the license information.

At this point simply click on the Finish button 

and the window will close.

The software is now ready to be used.

By default, SESLicenseManager will automatically send the activation file to SES via email. Under certain

circumstances, for example depending on your firewall settings or whether you have an email account set

up on your PC, the file may fail to send. If this occurs, a notification will typically appear on your screen,

16



and it is requested that you email the activation report to SES manually at KeySupport@sestech.com. The

activation report file, KeyVerify.dat, is found in the SES Documents Folder, which can be accessed by

double-clicking the SES Software shortcut and then:

Program Folders | Documents Folder

You may also notice other files in this folder, for example KeyDiagnostics.dat, which is a diagnostic report

that is sent to SES when the Send button is clicked from the SESLicenseManager main screen.

KeyOARequest.dat contains the offline activation request that would be generated and sent to SES if off-

line activation was requested.

The software license protection key, as shipped, is valid for a limited time. The SESLicenseManager utility

requires the license file to renew the protection key. SES will provide you with this license file (by email).

17
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Activating the Protection Key on a New PC

Activation of the protection key is required before it can be used. The activation can be done from any cli-

ent computer. Please follow the same steps as outlined in the topic Updating the Expiration Date of the

Protection Key to activate the protection key.

18



Safe Engineering Services & technologies ltd.

3055 Blvd. Des Oiseaux, H7L 6E8, Laval, Québec, Canada
Tel.: 1 450 622-5000 - Fax: 1 450 622-5053

email: support@sestech.com
Website: www.sestech.com

mailto:support@sestech.com?subject=Information Regarding Select Application Name
http://www.sestech.com/

	Select Application Name Network Installation
	Installing the Network Software Protection Key
	1. Introduction
	2. For a Quick Start...
	3. How to Upgrade your Key

	Server Installation of a Sentinel network Key
	4. Server Installation
	5. Server Management
	6. Client configuration

	Server Installation of a NetHasp Key
	7. Installing and Configuring the License Manager
	7.1 Installation Considerations
	7.2 Configuration
	7.3 Installation Steps

	8. Starting and Stopping the License Manager
	9. Using SESNetKey to Configure Network Keys
	10. Configuring the Clients
	11. Using SESLicenseManager to Configure Concurrent Runs
	12. Using SESLicenseManager to Configure License Usage Logging
	13. The Monitor Tool
	13.1 Installing the Monitor
	13.2 Using the Monitor



	Software License Protection Key - Updating the Expiration Date
	14. SESLicenseManager Program

	Activating the Protection Key on a New PC




